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1.  Preface 

The eTurboTouch touch panel is the most intuitive pointing device available for 
the PC series of computers and monitors. Touch panels make using computers as 
simple as touching the screen. It is ideal for a variety of applications, including 
entertainment, training systems, information, point-of-sale, factory automation, 
laboratory and medical instrumentation, interactive selling demonstrations, 
educational programs and so on. 

To use the Touch panel with your host computer or device, you have to install 
controller, the touch panel and the corresponding software. For the instruction of 
installing touch panel, refer to Sensor Kit Installation Guide. For the hardware 
connections for your controller, please refer to the Controller reference guide. 

Introduction 

eTurboWare converts the data from the touch panel to emulate input from a 
mouse device. eTurboWare for Windows is the software for the eTurboTouch 
touch panel. It provides full touch panel functionality for all applications running 
under Linux. 

After you finished installing eTurboWare, you can select and drag objects using 
the touch panel. To make a selection, simply touch the screen slightly. 

This manual provides the following information and will be described later by 
chapters. 

n Install this software 

n Use the touch panel (control panel) to customize your work environment 

n Troubleshooting  

♦ Important: Before installing software, you must complete the appropriate 
hardware connections for your controller and touch panel. 
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Installation 
To install the eTurboWare for Linux, please follow the steps below: 

1. Make sure you have left Xwindow system. 

2. Under the root directory, copy the file “eTurbo.tgz.0613” from the 
eTurboWare CD to the root directory. 

3. Unzip the file by typing “tar –xvzg eTurbo.tgz.0613”. An “eTrubo” directory 
will be created automatically and the extracted files will be stored on that 
directory. 

4. Go to the directory “eTrubo”. And type “make” command. Remember to 
choose the default setting (#1) for module built-up. 

5. Type “make install” to initiate the installation. 

6. After the installation is finished, please restart your system. 

When you installed a brand-new controller, you have to do 2-point calibration 
first before the first reboot. Please use mouse or keyboard to finish the work.  

♦ Note: Before you using eTurboWare, please open the README file first 
to have some information that you have to notice. 
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2.  Using eTurboWare 

You can change the software settings for your system, such as changing the 
calibration methods, touch modes, cursor options, hardware, and diagnostic tools 
to suit your preferences. 

To make sure you can invoke command with a touch, two steps listed below 
should be done.  

n Calibrating your screen, refer to page 9 

n Configuring your mouse, refer to page 11 – Touch Setting  

Using eTurboWare 

To open eTurboWare, please follow the steps below: 

1. Launch Xwindow. 

2. Locate and click the “touchcfg” icon on the desktop. Click Ok after the 
system finished searching all devices. 

3. The eTurboWare main screen will appear as follow: 
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Knowing the Tool Bar 

 

 

 

 

Hardware Information 
It displays the Linearization Parameters. The function of this tool is the same as 
Setting – Hardware Parameter menu item.  

Draw Test 
The function of this tool is the same as Tools – Draw test menu item. 

5pts Calibration 
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The function of this tool is the same as Tools – 5pts Calibration menu item. 
25pts Calibration 
The function of this tool is the same as Tools – 25pts Calibration menu item. 

Terminal Emulator 
This tool allows you to type firmware command on the command line. The result 
will be shown on the terminal message window. 

Touch Mode 
This tool allows you to set some touch mode for your touch panel. 

Calibrating Your Screen 

To make the touch panel to locate the correct position for each touch, you have to 
do calibration after the hardware and software installation are finished.  

When should you calibrate the screen: 

l The first time you run eTurboWare, you have to do 2 points calibration first. 

l Each time you change the video resolution (for example 640x480 or 
800x600) or video mode of your monitor.  

l Any time you change the size of the video image by adjusting the horizontal 
and vertical controls on your monitor.  

l If the cursor does not follow the movement of your finger (pointing device), 
or can not reach the edges of the screen. 

2-Point Calibration 
To have a 2-point calibration, please 

1. Click the “2Pcal” icon on the desktop window to initiate the 2-point calibrate. 

 

2. The screen with 2 points for your calibration appears. 

3. Touch on the blinking one with your finger or pointing device for a while. If 
it is OK, the point will change into green “X” and keep steadily. 
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4. Now, finish the second point calibration. 
5. You have done the panel mapping.  

5-Point Calibration 
To have a simple mapping with linearization compensation, execute 5-point 
calibration to get the result. When you select this function, 5 points display on 
your screen. Please touch on it in a while until it changed color into green (means 
calibration of that point is OK) and then release your finger or pointing device.  

To have a 5-point calibration, please 

1. Select “5 pts Calibrate” command from the Tools menu. The screen with 
5 points for your calibration appears. The center point blinks to push you to 
do the calibration. 

 

2. Touch on the blinking one with your finger or pointing device for a while. 
If it is OK, the point will change into green “X” and keep steadily. 

3. Follow the instruction on the screen to touch every point.. 

4. When you finish these steps, you have done the panel mapping. 
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25-Point Calibration 

This command defines the X and Y axis position for a touch. When you select 
this command, 25 points with black background will display on your system 
screen. The point to the left-bottom side will blink to ask you to do the 
calibration. Please touch on it by your finger or any point device in a while until 
it changed from blinking into steady “X”.  For calibration, you have to touch 25 
points one by one. 

♦ Note: As this command is used for compensation if the touch panel got 
some problem of bad linear, it is not recommended to invoke it.  

For 25-point calibration was done by factory as a default setting, in general, you 
do not need to execute this action again. Yet, if you really want to do, please 
follow the steps below: 

1. Select “25 pts Linearization” command from the Tools menu. The screen 
with 25 points for your calibration appears.  

2. Touch on the blinking one with your finger or pointing device for a while. 
If it is OK, the point will change into green “X” and keep steadily. 

3. Follow the instruction on the screen to touch every point. 

4. When you finish these steps, you have done the panel mapping. 

Draw Test Window 
The Draw Test Window is provided for you to do simple test of finger touch. 
You can draw lines with your finger or any pointing device.  

To invoke this window, please select “Draw Test” command from the Tools 
menu. 

To exit this window and back to the Diagnostic dialog box, please press <ALT> 
+<F4> simultaneously. 

Touch Setting 

You might want to configure some settings after installing eTurboWare. Touch 
Setting allows you to set your touch mode such as Touch Mode, Right Click Tool, 
InPlace, Drawing Delay and Click Delay.  
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Touch Mode 
There are three selections for the Touch Mode, 

Button Mode -  In Button mode, touching the screen is equal to pressing 
and/or releasing the mo use button. 

Drawing Mode -  Drawing mode is useful for draw and graphics applications. 
In Drawing mode, a touch is equal to pressing and holding 
down the mouse button. Lifting off your touch is the same 
as releasing the mouse button.  

Click Mode -  It is useful for general-purpose desktop applications. In this 
mode, a touch positions the cursor much like a mouse. 
Holding the touch is equal to pressing and holding the 
mouse button. Lifting the touch off is equal to releasing the 
mouse button.   

Right Click Tool  
This command applies the right mouse button function for a touch. The limitation 
is that it can be used just once. If you want to apply the function for next use, you 
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must choose this command again. 
Drawing Delay 
Defines the time that you must touch the screen for your system to interpret your 
actions as a click. Adjust it to the right to set the range for each touch be larger; 
adjust it to the left to set the range for each touch be smaller.  

Click Delay 
Defines how quickly you must touch the screen for your system to interpret your 
actions as a click. Adjust it to the right to set the speed for each touch be slower; 
adjust it to the left to set the speed for each touch be faster. 

InPlace 
The Inplace defines the area (range) in which you must touch the screen for your 
system to interpret your actions as a click. 
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25pt Parameters 
This command provides the hardware information of X and Y coefficients. 

Please select “Linearization Coefficients” command from Tools menu, a dialog 
box appears as follows: 

 

Reload –  The information that you erased by clicking on Clear button can 
be reloaded with this button. 

Clear – Erase current information. 

Save – Save the settings. 

Close – Close this dialog box. 
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On-Line Help 
eTurboWare will offer an on-line help for your reference whenever you want to 
know the detailed information about each commands.  

Exiting the eTurboWare 

When you finish all the setting adjustments, you can exit the eTurboWare main 
screen. Choose Exit from the File menu to make all the settings take effect.  
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3.  Troubleshooting 

This chapter will provide you some notice and specific information for your 
reference. 

Important Notice 

n If you have rotated the sensor for some reason, before using it, please 
execute 2-point calibration. The 2-point calibration will not affect 5-point 
and 25-point calibration unless re-calibrated. 

n The power for controller is supplied by keyboard PS/2 power. For Wind9X 
OS, when the system goes into suspend mode, it can be waken up by mouse 
or keyboard but can not be waken up by a touch (which can call back the 
system when goes into display protection). To avoid such problem, please 
provide another DC-5V to the controller. 

n For LCD video rotation, it is not necessary to do re-calibrate with 2-point. 
The LCD video coordinate is separate from touch coordinate. 

n The driver/utility v1.05 is compatible with firmware 1.00 and later. Before 
you install a new driver /utility to your system, please check the controller 
firmware’s version. Choose About Touch button from the Controller List 
dialog box to get the firmware and driver version information. 

n The touch panel provides less 1.5accuracy fail message. The 1.5% length of 
sensor active area and 1.5% wide of sensor active area offset is acceptable. 
However, the calibration accuracy will affect this result and sensor size. 
Besides, the larger offset distance will appear. 

n Before you install a new driver into your system, please remove the old 
version first if it exists on your system. The new driver will not replace the 
old one but create another folder instead. 
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Q & A 
Q: The eTurboWare can not be closed by your touch. 

A: As the application utility window (main screen) will interrupt the comport, we 
strongly recommend – do not launch the application software without a mouse 
or keyboard installed. Otherwise, you might not close the software properly. 

Q: I change a new controller for my touch panel. What thing should I 
take care? 

A: For a brand-new controller, please do 2 points calibration first. Due to the new 
one has not any data of your touch panel, you have to launch 2 points (panel 
mapping) calibration by using a mouse or keyboard. 
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